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ColorCalculator User Guide 

I. Overview 
 

The ColorCalculator software was developed by Osram Sylvania, Inc to help users design color mixing 
LED lighting solutions.  The software has two main modes of operation along with several other useful 
features. The main start-up window is shown in Figure 1. 

The two main modes of operation are: 

1) General photometry.   
- The user either selects the intensity of several LEDs or inputs a spectrum and the 

program calculates several photometric quantities. 
2) Design optimization. 

- A set of desired photometric values are specified by the user and the program calculates 
the intensity of the LEDs required to obtain the design. 

 

The photometric quantities are derived from equations given in CIE documents 13.3 and 15.2  

II. Installation and Program Files 
 

The program is completely self-contained in the ColorCalculator.exe file, no other files or dll’s are 
needed. The executable can be moved to any directory or copied to any computer without having to be 
installed. The program will create several file when run. These files have names such as: 
ColorCalculator.ini, userSpectra.spec, userFilters.fils, userColors.cols, photometry.txt. All of the files 
created by this program are in plain text can be viewed in a standard text editor but should not be 
changed by the user. Other files may be created but with user defined names. 

 

1. Windows Version 

The downloaded file is a self-extracting zip file. Save it you your hard drive and double-click. Select the 
folder you want to save the program in. Two files will be saved: ColorCalculator.exe and 
ColorCalculator_User_Guide.pdf (a copy of this document). 

The files the program writes are written to the directory where the ColorCalculator.exe is located. You 
may want to put the ColorCalculator.exe in a central location and create Windows shortcuts to this exe 
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in other folders. Then you can edit the “Start in:” directory of the shortcut so that all files will be written 
to the directory where the shortcut is located. In the example below the shortcut name is 
“ColorCalculator.exe – Shortcut”. You can put shortcuts in several directories and edit each shortcut so 
the “Start in” is empty this will results in all files being saved to the local directory where the shortcut is. 
This is helpful if you are working on several different projects with different design requirements. See 
Windows help for more information on working with shortcuts. 

 

 

2. Mac OS X Version 

The Mac version runs in X Windows (X11). If you double-click the program and you only see a terminal 
window you need to install the X11 libraries. X Windows (X11) can be installed using the XQuartz project 
files (https://www.xquartz.org/). 

The download file is ColorCalculator.dmg.zip, unzip it by double-clicking it. Open the .dmg file and save 
the two files within, ColorCalculator (the executable) and ColorCalculator_User_Guide.pdf (a copy of this 
document). You start the program by double-clicking the executable in Finder. The program will try and 
create a directory called “%HOME%/ColorCalculator_OSI/” where your user files and the ini files will be 
kept. If this directory cannot be created these files will be stored in your %HOME% directory. 
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III. Main Modes of Operation 
 

Not all of the available menu commands will be discussed in details here. Most of them should be fairly 
obvious to the experienced designer or may be best understood by trying them. Also, if you let your 
mouse pointer hover over an input box many of the input boxes have a small pop-up help description. 

 

Figure 1.  Main window at start-up. 

 

1. General Photometry 

The user selects the LEDs to include in the design (by checking them), enters the dominate wavelengths 
and the intensities. The intensity can be entered as watts or lumens and these can be mixed. Once the 
design is entered the “Calculate” button is clicked and the results are displayed in the window and the 
resultant spectrum is displayed in the table. The spectra from the individual LEDs are combined together 
additively to give the spectrum of the mix. By default, the photometry results are also written to a text 
file called “photometry.txt” in the directory where the ColorCalculator.exe is located.   

The user can also enter a spectrum directly into the table. This is done by first selecting the “Direct 
spectrum input” as the “Analysis type” and pasting the spectrum into the table. You can enter the 
spectrum at predefined wavelength intervals or in a free format. The wavelength intervals can be 
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selected from the menu item “Inputs->Spectrum from….”. If the “Inputs ->Free format spectrum” is used 
then the program will resample the entered data to the calculation points. The free format spectrum is 
useful when importing data from photometric sphere measurements where the data is not measured at 
regular intervals. 

 

 

 

Once a design has been entered it can be saved for later use. To save a spectrum first perform a 
calculation then click the menu item “User Spectra->Save as user spectrum”. You will be prompted to 
enter a name and a LPW. Entering the LPW is optional, you may leave this blank. All of the user spectra 
you save are written to a file called “userSpectra.spec” in the directory where the ColorCalculator.exe 
file is located. The “userSpectra.spec” file is in plain text and can be viewed in any standard text editor. 
Under the “User Spectra” menu item are several other functions useful in maintaining and manipulating 
your saved spectra. 

The program can read certain file formats directly without the user having to cut-and-paste the data by 
hand. The program can read data files from the SpecWin and SpectraSuite software packages and the 
IES XML standard format. The “SpectraSuite” format will also read-in an asc file with two columns of 
wavelength and intensity. You can encode the drive current and forward voltage in the filename and the 
program will parse these out and calculate the LPW and include this information in the photometry.xls 
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file. Example files names are “test_led_3.1V_50mA.isd”, “test led 3.1V 50mA.isd” and “test led 50mA 
3.1V.isd”. The important feature is that you must use ”V” to indicate the forward voltage and “mA” to 
indicate the drive current, with no space between the number and the symbol.  Both must be 
surrounded by ether underscores or spaces or be at the beginning or end of the file name for this 
feature to work. You can also use “W” for readings from a watt meter. 

Spectra for current LEDs from OSRAM Opto Semiconductors can be downloaded from our web site at 
https://apps.osram-os.com/Characteristic 

 

 

 

You can also read in several spectra at the same time. Enter them in Microsoft Excel then cut and paste 
them in a text file using something like Notepad, see Figure 2. If this file has text in the first row it will be 
used as the names of the spectra when they are saved. This file is tab delimited so the columns names 
appear to be shifted from the values. 
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Figure 2.  Example file containing 5 spectra to read in. 

 

2. CIE Diagram Plots 

There are 5 different CIE color spaces available for plotting. The standard CIE 1931, 1960, and 1976 2° 
color spaces, and 2 newer diagrams based on the CIE 170-2:2015 color space. These new color spaces 
use the color coordinates of xF,10, yF,10 and u’F,10 and v’F,10. The CCT F,10 and lumens F,10 are also calculated 
for this 2015 10° color space. These results are given on tab 4. 

There is no way to convert from x,y to xF,10, yF,10  directly, xF,10, yF,10 must be calculated from the 
spectrum. In these new 2015 plots the conversion from xF,10, yF,10 to u’F,10 and v’F,10 is made using the 
standard conversions. It is not clear if this is strictly valid but should be a good approximation. It is best 
to use the u’v’ circles in the new 2015 space over the MacAdams ellipses but the software will allow the 
use of the MacAdams ellipses as an approximation. 

 

3. Design Optimization 
 

The user selects several LEDs to include in a design, specifies a set of photometric targets and the 
program adjusts the intensity of the LEDs to reach the target design. It is best to first find a design that is 
reasonably close to your target, as described in the previous section. In Figure 3 the optimization 
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method is “Target a CRI”. The target CRI is defined as 80 with a CCT within 50K of 3000K and a Delta(uv) 
of 0.002.  Also, a minimum R9 of 40 is specified. Only some of these parameters need to be specified.  If 
an input box is left blank it will not be constrained. Once you click the “Calculate” button the program 
will prompt you to enter any required values that you left blank.  In order to optimize for the LPW, the 
LPW of all of the LEDs included in the design must be specified. You will be prompted if any are missing. 
 
The TM-30 optimization method can work in 2 ways. You can enter targets for the Rf, Rg and/or Rf,skin and 
the program will try to hit these targets. Only one of these need be entered. Another way this method 
works is if you enter a ‘+’ sin in either the Rf or Rg fields the metric with the ‘+’ symbol will be maximized. 
Any other parameters entered will be used a minimum values. 
 
If your optimization is successful the new intensity values will be copied to the correct input boxes for 
you to run a complete calculation. If you do not like the design you may return to the original intensity 
values by clicking the “Reset values” button. If the optimization is not successful you may need to relax 
some of the optimization constraints, begin with a better design or add more LEDs to the design. 
 
While design optimization is a very powerful tool it may not be the best approach to find a desirable 
design. One of the drawbacks is that it gives you only one “best” design. There may be a design that is 
very close to the “best” but has some advantages that would lead you to select it over the “best” design 
if you were aware of it.  

 
 
 
 
 
 
 
 
Figure 3.  Portion of the main window 
used to define the optimization targets. 
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IV. Other Functionality 
 

1. Filters 

A filter is used in some applications to control some aspect of the light. You can enter and save a filter 
much in the same way as a spectrum can be saved. To enter a filter select the “Filter input” “Analysis 
type” and paste your transmission data directly into the table, click the “Calculate” button to have the 
program check the data. You can then use the “User Filters” menu item to save or manipulate your user 
filters as you would your user spectra. The transmission is defined as between 0 and 1 or as a percent 
from 0 to 100. The units can be changed in the “Data” menu item. The saved filters are saved to a plain 
text file called “userFilters.fils”. 

If you use filters it is helpful to create a user spectrum that has a value of 1 for the intensity at all 
wavelengths. This can be used to check your filters by selecting the constant spectrum and a filter. The 
resultant plot will be a plot of the transmission of the filter. 

 

2. IES TM-30-18 

The IES TM-30-18 metric is calculated, and the values are displayed in the output sections as shown 
below. 
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There are various plots available. These can be accessed using the “IES TM-30-18” and “Other Plots” 
menu items. 

 

 

 

 

 

 

The “TM-30” toolbar item shows an overview of the TM-30 report. This report can be customized using 
the “IES TM-30-18 report” in the menu above and a typical report is shown in Figure 4. 
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Figure 4.  TM-30-18 report. 
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Figure 5. 3D plot of TM-30 points. This plot can be rotated and/or animated. 
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3. Color Quality Scale (CQS) 

The Color Quality Scale is being developed by NIST (National Institute of Science and Technology) as a 
possible replacement for the Color Rendering Index (CRI) for use with LED light sources. A full 
description of the CQS is given in W. Davis, Y. Ohno, Optical Engineering, v49(3), 033602 (March 2010). 
The user can switch back-and-forth between the CRI and CQS using the tabs at bottom left of the main 
window as highlighted below. 

 

 

 
 

4. Colors 

The individual values in the CRI and CQS scales (R1-R14 and Q1-Q15) give a measure as to how well the 
test source will render a color as compared to the reference source (a black body at the same CCT). The 
individual colors in the CRI and CQS scales were chosen for their general applicability. However, in some 
cases, you may want to see how a different color will be rendered. To do this you can define a “user 
color”. A user color is defined by entering the spectral reflectance representing the color. The measure 
of how well this color will be rendered compared to the reference source will be calculated using the 
CQS formulation and written to the “photometry.txt” file for each user color checked. The user colors 
can be managed in the same manner as the user filters. The reflectance is defined as 0 and 1 or as a 
percent from 0 to 100. The saved colors are saved to a plain text file called “userColors.cols”. 
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5. Custom CIE Plots and Delta(uv) 

The delta(uv) is a measure of the distance a point is from the black body locus in u-v space. The 
delta(u’v’) is a measure of the distance a point is from the black body locus in u’-v’ space. For “white” 
light you generally want delta(uv) to be below 0.0020. If you have x,y data and want to plot it on a CIE 
diagram or calculate the CCT or delta(uv) values you can click the button with the CIE icon with the “C” 
near the top of the main window. A new window will open where you can enter your data and have the 
program plot your points and calculate the desired values. This can also be used to plot more than one 
point on the CIE diagram. 

 

If you have several spectra you want to plot at the same time you can take the following steps. After a 
calculation click the “x,y” button near the top of the main window.  This will save the x,y data for the 
spectrum that was just calculated. Repeat this for as many spectra as you wish, click the button, and in 
the new window that opens click the “x,y” button. The saved x,y pairs will be written into the table. 
Then click the “calculate” button to plot the data. 

 

You can clear the saved x,y pairs by clicking the “Data->Clear all saved x,y values” menu item on the 
main window or by restarting the program. You can also check several spectra and press the “Cal 
Individual” button. This will calculate each checked spectra individually and automatically save the x,y 
point. These can then be pasted into the Duv table using the method described above.  

From this window you have several features such as; change plot symbols, show/hide the MacAdams 
ellipses and/or u’v’ circles for the individual points. You can also display one MacAdams ellipse centered 
on all of your points. You can also enter only the CCT and the program will calculate the x,y for a point 
on the black body at this CCT. This is useful for adding reference points to a plot. 

If you left-click on a plot symbol you will see the pop-up as shown in Figure 7. You can select the symbol 
for each individual point. You can apply the same symbol to several points at once if the points are in 
adjacent rows. To do this you click on the first row, then press “cancel” at the bottom, then hold down 
the shift key and press the plot symbol in the last row and pick your symbol. You can save your selected 
plot symbols and point labels to a file to use later using the “Save as…” menu item. The information will 
be written to a text file. If you have a lot of points with complicated symbol and text selections you can 
create this file yourself. The symbol shapes go left-to-right from 0 to 9, the colors go top-to-bottom from 
0 to 19. The data must be separated by either spaces or tabs and the labels (if present) must be 
enclosed in double quotes. You should first save a file using the program so see the exact format. 
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You can display predefined gamuts or define your own. You can also enter your own ellipse definitions. 
See the “Help” menu item on this window for more information. 

 

 

Figure 6. Input form for the Delta(uv) calculations. 

 

 

Figure 7. Plot symbols and colors. 
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6. R-Values Plots 

You can make a plot of the R-values or Q-values, depending on which metric is selected. After a 
calculation click the button circled in red below. 

 

You will see a plot similar to the one below (Figure 8).   

 

Figure 8.  R-value plot. 

You can plot the R-values from several spectra on the same plot by saving the R-values by clicking the 
button circled in red below. You can clear the saved R-values by clicking the “Data->Clear all saved R-
values” menu item on the main window or by restarting the program. 
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7. Subtract Blue Peak 

The “Subtract blue peak” option will automatically fit the blue peak and subtract it from the spectrum. 
The amount of watts in the fitted blue peak and the remaining peak (called the phosphor peak) will be 
reported in the output. The spectrum without the blue peak will be plotted as a solid black line so the 
user can see the fit and evaluate if it is reasonable. The calculated watts in each peak are usually good to 
within 10%. These values only are meaningful for LED sources. 

 

 

 

 

Figure 9.  Spectrum with the blue peak fit. 
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8. Evaluation of Binning 

The effects of bin selection can be simulated using the “Other Calculations->Calculate binning from x, y 
and lumens…” menu item. You enter the information for your design in terms of the LEDs used and their 
lumen levels. Enter the color and lumen bin information and a Monte Carlo simulation is used to 
generate several thousand data points which are then used to show the expected color spread on the 
CIE diagram and in terms of MacAdam ellipses. The only option available in this simulation is whether or 
not to skew the bins of the non-pure color LEDs. The figure below shows a typical skewed bin. You can 
see the effect by only checking the bin to be skewed and see if you like the effect. 
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With skew effect 

 
Without skew effect 

 

 

9. Other Plot Types 
 

a. Spectrum Plots 
 
You can save the plot of a spectrum to a file as a bitmap image. To save the spectrum click the button 
circled in red below. A window will open with only the spectrum plot in it.  You can resize the plot and 
save it to a file. 
 

 

 
 
 

b. CIE Plots 
 

You can save the plots of the CIE diagram to a file as a bitmap image. To save the CIE diagram click the 
button circled in red below.  A window will open with only the CIE diagram plot in it. You can resize the 
plot and save it to a file. There are several options in the menu of this window that allow you to tailor 
the plot in many ways. The display of the MacAdam ellipses can also be controlled in this window. 
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c. Matching Plots 

If you check the “Matching->Matching mode” menu item a new column will be added to the table. You 
can paste a spectrum into the column labeled “Matching”. When you calculate the spectrum this 
“matching” plot will also be plotted. You can also select to use the photopic curve as the matching 
spectrum by checking the appropriate box in the “Matching” menu item. 

 

d. CIELAB Plots 

You can make and save CIELAB plots of either the CRI, CQS or user colors to a file as a bitmap image. To 
display the CIELAB plot click the button circled in red below. A window will open with the CIELAB plot in 
it. You can resize the plot and save it to a file. The CMCCAT2000 chromatic adaptation is used to correct 
the CQS and user colors and the von Kries chromatic adaptation is used to correct the colors. The plot 
can display the results as individual points of as vectors connecting the test and reference points, color 
rendering vectors (CRV). You can also make these types of plots using any user colors you have any 
defined and checked. You can also plot MacAdam ellipses and/or u’v’ circles on the plot. The vectors can 
also be scaled by the size of the corresponding MacAdam ellipse. The scaling is helpful in that vectors of 
the same size will indicates that the color shifts are effectively similar. The ellipses area always 
calculated assuming L* is 100. 
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Figure 10.  CIELAB plot of the 14 R-values for the reference and test light source. 
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Figure 11.  CIELAB plot of the 14 R-values for the reference and test light source showing color rendering 
vectors (CRV). A vector pointing toward the center indicates that a particular color is under saturated, a 
vector pointing away from the center indicates that the color is oversaturated. Vectors pointing in a 
rotational direction indicate that there is a shift in hue for a color. Longer vectors indicate larger shifts in 
color and/or saturation. 

 

Once the plot is displayed you can list the L*, a* and b* values (and related metrics) in a table by clicking 
the “Data->Show the data values in a table” menu item. 
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Figure 12. Values used to make the CIELAB plot. 

 

 

e. Color Rendering Plots 

How well each color is rendered can be seen using the “color patch” plot, Figure 13. The plot can be 
seen using the “Other plots->Show color patches of R, Q or user colors” menu item. You can also show 
user colors, if you have any defined and checked, using the “Plot type” menu item. Note, the colors are 
only approximate and are rendered as sRBG assuming a gamma of 2.2 and normalized to 100 lumens. 
The CMCCAT2000 chromatic adaptation is used to correct the colors and the source illumination is D65. 
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Figure 13.  Color patch plot of the 15 R-values for the reference and test light source. 

 

f. IES TM-30-18 

After a calculation is performed, plots according to the IES TM-30-18 standard can be made. There are 
several different types of plot available in TM-30-18. You have to use the “Image Type” menu command 
on some of the plot windows to switch between image types. The numeric results are displayed on tab 
#2. 
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10. Other Features 
 

a. Generic Pure Color LEDs 

You can also display what are called “generic pure color LEDs“ in addition to the standard packaged LEDs 
shown by default. You can control what types of LEDs are displayed with the “Other options” menu 
item. The “generic pure color LEDs” are mainly of interest to designers using the “Total combinations” 
method previously described. These LEDs have their peak shapes defined by Gaussian fits. Each peak is 
represented by a fit of three individual Gaussians which were derived by fitting to experimental data.  
The peak shapes change with the dominate wavelength. When these LEDs are shown the “Total 
combinations” window looks as shown below. In addition to the standard LEDs you can chose these 
generic LEDs and include the wavelength variation in a combinations run. 

 

b. Black Body and Daylight Spectra 

You can display the spectrum of a black body or reconstituted daylight at any CCT. This can then be 
saved as a user spectrum or used as a matching plot. 

 

c. Pure Color and Gaussian Peaks 

You can have the program generate a pure color peaks or simple Gaussian peak to represent an LED.  
Click the “User Spectra->Generate user spectra from pure color or Gaussian peaks…” menu item. Select 
the LED type, then enter the peak information and program will generate the spectra and add it to your 
user spectra. You can generate many of the same type of peak, with different parameters, at once. 
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d. MacAdam Ellipses 

The program will calculate the points for a MacAdam ellipse for use in other plotting software. Use the 
“Other Options->Calculate coordinates of MacAdam ellipse…” to display this window: 
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You can enter the ellipse center and the other parameters and the points describing the ellipse will be 
written to the table. These parameters are always for a 1-step ellipse. Note that the ellipse is based on 
equations from: Chickering, JOSA V57 n4, "Optimization of the MacAdam-Modified 1965 Friele Color-
Difference Formula" and Chickering, JOSA V61 n1, "FMC Color-Difference Formulas: Clarification 
Concerning Usage". 
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e.  Adding Color Points 

You can add a series of x,y and lumen value to see the resultant color point. 

 

 

 

 

 

Figure 14. Input form for the additive x,y and lumen calculations. 

  



31 | P a g e  
 

 

f. Calculating CCT, Duv, Ldom and Purity from x,y or u’v’ 

You can enter x,y (or u’v’) values and calculate the CCT, Duv, dominant wavelength and purity. The 
dominant wavelength and purity depend on the reference point used, this can be selected by the user. 
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g. Calculating x,y from CCT and Duv 

You can enter values for the CCT and Duv and have the program calculate the corresponding x,y color 
points. The program solves for the x,y and then uses these to redo the forward calculation to calculate 
the CCT and Duv so you can compare the calculated to inputted values as a check on the solution. 
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h. Convert Between Different Coordinate Systems 

You can convert between different sets of color coordinates. Enter any set (xy or uv or u’v’ or XYZ or 
L*a*b*) and the others sets will be calculated. You can enter a lumen level or, if none is specified, the 
program uses a default of 100. For conversion to and from CIELab space a white point must be entered. 
If you are not interested in the L*a*b* values this white point can be ignored. 

 

 

 

 

 

 

i. Natural Colour System (NCS) 

The Natural Colour System is a color notation system developed and supported by NCS Colour and is 
the property of and used on licence from NCS Colour AB, Stockholm 2013. The system is comprised of 40 
hues, a blackness level (vertical axis) and a chromaticness level (horizontal axis). More information can 
be found at http://www.ncscolour.com/.  

These colors can be selected and used as user colors and can then be used to generate color rendering 
vector plots (CRV) to give a designer an indication as to how a light source will render a wide range of 
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colors, section C. Figure 15 was made using all 1950 of the NCS colors as user colors. This plot is much 
more informative than the similar plots shown in Figure 8 which was made using the 14 CRI R-value 
colors. 
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Figure 15. CIEL*a*b* plot of the 1950 NCS colors for the reference and test light source showing color 
rendering vectors (CRV). 
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j. Class A Light 

J.P. Freyssinier and M.S. Rea of the Lighting Research Center at Rensselaer Polytechnic Institute and 
Alliance for Solid-State Illumination Systems and Technologies (ASSIST) have proposed a specification for 
what they call “Class A” lighting. Detailed information on this work can be found at 
http://www.lrc.rpi.edu/programs/solidstate/colorResearch.asp and 
http://www.lrc.rpi.edu/programs/solidstate/colorResearch.asp . 

 

k. Three Color Mixing 

The “Other options->Calculate 3 color mixing based on x,y…” menu item will show the following 
window. Enter the x,y coordinates of the three color sources in the top table. In the “Targets” table 
enter either the CCT and Duv or the x and y of the desired mixed light and the required lumen level of 
each of the three colors will be calculated. You can either enter a value in the “Total lm” column or leave 
it empty. If it is left empty then a default value of 100 lumens will be used. 
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l. Spectra Mixing 

The “Other options->Calculate color mixing based on spectra…” menu item will show the following 
window. The checked spectra (up to 4) from the main window will be used in these calculations. The 
watts or milliwatts of each color can be entered and the photometry will be calculated. 
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m. Maximum Lumens From a Color Mix 

The “Other options-> Calculate maximum lumens from color mix...” menu item will show the following 
window.  This is designed to calculate the maximum lumens you can get from a set of LEDs and a color 
mix. You define the performance of the LEDs in the upper table, inputting the lumens and visible watts 
at maximum power. In the lower table you enter your color mix, either based on the percent of visible 
watts in the spectrum from each LEDs or on the absolute watt level. The program then calculates the 
maximum lumens achievable and the intensity limiting LED and the duty cycle. This calculation is also 
available in the “Run combinations” method described in section III/3 of this report.  

 

 

 

 

 

 

 

n. Circadian System Response 

The “Other options->Calculate Circadian system response…” menu item will show the following window. 
First you must select and perform a calculation from the main window. You can enter the Lux values and 
have the program calculate the resultant CLA and CS values, or enter a target CS value and the required 
Lux and CLA values will be calculated. The Circadian system response calculation is based on work by 
M.S. Rea, M.G. Figueiro, J.D. Bullough, A. Bierman and R. Hamner at the Lighting Research Center, 
Rensselaer Polytechnic Institute, Troy, New York, USA. 
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o. TLCI-2012 Metric 

The TLCI-2012 metric refers to the Television Lighting Consistency Index, as specified in EBU Tech 3355. 
It is used to evaluate the suitability of a light source for use in television. A complete description is 
available on the web at https://tech.ebu.ch/tlci-2012. Below shows sample output for the 2700K white 
LED included in the program. There are 2 buttons with slightly different TLCI calculations. The button on 
the left will run the calculation with the reference light source as defined in the standard. The button on 
the right will allow the user to select the spectrum to use as the reference light source.  
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p. Horticulture 

The leaf icon on the toolbar will display the photon flux in specific wavelength ranges. The wavelength 
ban (300-1050) is only displayed if there is any flex above 800 nm. 
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IV. Description of Menu Commands 
 

A brief description of each menu command will be given. For many of these the meaning is obvious or it 
can be easily ascertained by trying them. 

 

1. Main Window 

 
a. File Menu 

 
i. “Open design file…” 

Open a previously saved design file. This contains all of the settings you can set in the UI. 

ii. “Save design as…” 

Saves the current state of the UI to a file. These setting can be read back in using the “Open design 
file” command.  

iii.  “Clear recent project list” 

Clears the list of the recently used design files. This will be grayed out if no design files have been 
used. 

iv. “Open photometry.txt file” 

Opens the photometry.txt file in a simple text editor. This file contains a surrey of all of the runs 
performed since the program was last started. It is overwritten each time the program is restarted. 
This file is only written to if the “Write to Excel” button is pressed or if the menu item “Data->Write 
photometry data to a file (photometry.txt)” is checked. 

v. “Open photometry.xls file” 

Opens the photometry.xls file in excel. This file contains a surrey of all of the runs performed since 
the program was last started. It is overwritten each time the program is restarted. This file is only 
written to if the “Write to Excel” button is pressed or if the menu item “Data->Write photometry 
data to Excel file (photometry.xls)” is checked. 

vi.  “Exit” 

Guess what this does? 
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b. Edit Menu 
 

i. “Select entire table” 

Selects the content of the table where the spectrum is displayed. 

ii. “Copy selection to clipboard” 
 

Copies the selected cells in the table to the clipboard. These values can then be pasted in other 
software. 
 

iii. “Paste selection to clipboard” 
 

Allows values to be copied from other software, such as Excel, to be pasted in to the table. 
These values must already be in the clipboard and can only be pasted when the program in the 
one of the input modes. 
 

c. Inputs Menu 
 

i. “Input power units (milliWatts)” 

Sets the watts units for the spectra to milliwatts. These are the values you enter into the UI to 
set how much of each spectrum you have. This does not affect values of any spectra which are 
read from files. 

ii. “Input power units (watts)” 

Sets the watts units for the spectra to watts. These are the values you enter into the UI to set 
how much of each spectrum you have. This does not affect values of any spectra which are read 
from files. 

iii. "Fill empty input intensity fields with lumens" 

If both the lumens and visible watts input field are empty the lumens field will be filled with the 
default values. 

iv. "Fill empty input intensity fields with visible watts" 

If both the lumens and visible watts input field are empty the visible watts field will be filled with 
the default values. 
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v. “Input units for filters and colors (fraction 0-1)” 

Sets the input units for filters and colors to fractional values. The values must be in the range of 
0 to 1. 

vi. “Input units for filters and colors (percent 0-100)” 

Sets the input units for filters and colors to percentage values. The values must be in the range 
of 0 to 100. 

vii. “Spectrum from 360-830nm (2nm)” 

Set the wavelength range and interval for the spectrum copied into the main table for the 
“Direct spectrum input” mode to 360-830nm in 2 nm steps. 

viii. “Spectrum from 360-830nm (1nm)” 

Set the wavelength range and interval for the spectrum copied into the main table for the 
“Direct spectrum input” mode to 360-830nm in 1 nm steps. 

ix.  “Spectrum from 380-780nm (2nm)” 

Set the wavelength range and interval for the spectrum copied into the main table for the 
“Direct spectrum input” mode to 380-780nm in 2 nm steps. 

x. “Free format spectrum” 

Set the wavelength range and interval for the spectrum copied into the main table for the 
“Direct spectrum input” mode to any range and any interval. The program does the photometry 
calculations from 360 to 830 in 2 nm steps. The inputted data will be extrapolated to fit this 
range and set to 0 if not data is provided. This input format is the most general and can always 
be used. 

xi. “Input units for spectrum” 

Set the units of the inputted spectrum to either: W/nm, milliWatts/nm, microWatts/nm or 
photon/s. These units are only in effect when “Direct spectrum input” is checked. 

xii. “Invert values in table” 

When pasting in a spectrum, filter or color into the table requires that the wavelengths values 
are arranged short to long, 360-830nm. If your data is in the opposite order (long to short) you 
can paste it in then click this command and the values will be flipped in the table. 
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xiii. “Limit umol/s-W to 400-700nm” 

Limits the calculation of the umol/s-W to the range of 400-700nm. If this is not checked then the 
umol/s-W will be calculated over the range of 360-830nm of 360-1050nm if the “Include IR” 
option is checked.  

xiv.  “Hide spectrum data when possible” 

The table with the spectrum data will be hidden unless you are in one of the input modes or are 
displaying a matching spectrum. 

xv. “Set empty cells in spectrum to 0” 

When inputting a spectrum any wavelength values not entered in the table will be set to zero. If 
this is not checked then any empty cells will cause an error.  

xvi. “Use original spectral intensity if lumens or watts are blank” 

If this is checked the user can leave both the watts and lumen values empty and the program 
will use the value of the original spectrum. If this is not checked then any empty cells will cause 
an error.  

xvii. “Clear spectrum data from table” 

Clear the table of any user entered data. This can also be accomplished using the red “x” button 
on the toolbar. 

xviii. “Clear all saved x,y values (0/2000)” 

Clears any saved x,y data from memory. After a spectrum is calculated you can click the “x,y” 
toolbar button to save the x,y values to an array. Also, if you selected several spectra and click 
the “Cal. Individual” button then each of the checked spectrum will be calculated individually 
and not summed, then the x,y values will automatically be saved to the x,y array. These saved 
values can then be pated into the Duv table (accessible by clicking the Duv toolbar button) and 
used to make more customizable CIE plots. 

xix. “Clear all saved R-values and Q-values (0/7)” 

Clears any saved R, Q data from memory. After a spectrum is calculated you can click the “Rn” 
toolbar button to save the R and Q values to an array. These can then be used to make R or Q 
values plots like that shown in Figure 8. You can use the current values or all of the saved values 
to make your plot by using the menu commands in the R-values plot window (accessible with a 
toolbar button). 
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xx. “Clear input data on start-up” 

By default the program will start each time with the final values from the last time it was run. 
Checking this will always start the program with no spectrum selected and lumen or watt values. 

xxi. “Reset all program default values” 

Reset any user changeable values to their default settings with no spectrum selected and no 
lumen or watt values. This can also be accomplished by deleting the ColorCalculator.ini file 
located in the same directory as the ColorCalculator.exe file. Note that any user spectra, filters 
or colors will not be affected; these are stored in separate files. 

xxii. “Update decimal format” 

The program is “international” aware, meaning that it asked the operating system whether to 
use a dot or comma for the decimal separator. You can reset this is the operation system and 
use this command to have the program reset itself to use the new value. 

 

d. Outputs Menu 
 

i. “Write current spectrum data to a text file” 

The current contents of the spectrum table will be written to a text file of your choosing. This 
can be read in using another command. This is in addition to being able to cut and paste the 
data to a file for saving. 

ii. “Write x,y, Duv with 4 decimals” 

Writes the x, y and Duv values with 4 decimal points resolution. 

iii. “Write x,y, Duv with 6 decimals” 

Writes the x, y and Duv values with 6 decimal points resolution. 

iv.  ‘Write the photometry data to a file (photometry.txt)” 

The results of each calculation will be written to a text file. 

v. “Write the gamuts, COI, Class A, TLCI & umol/s-W to the photometry.txt file” 

Write these quantities to the text file after each run. 

vi. “Write all photometry data to Excel file (photometry.txt)” 

The main photometric quantities will be written to an Excel file after each run. 
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vii. “Write the CIE 2015 CCT(F10), x(F10) and y(F10) values to Excel file (photometry.xls)” 

It’s all in the title. 

viii. “Write the TM-30-18 bin Rf,bi values to Excel file (photometry.xls)” 

It’s all in the title. 

ix. “Write u’v’ for the R-values, Q-values, and any checked User Colors to Excel file 
(CRI_CQS_u’u’.xls)” 

Calculates the u’v’ for the individual R-colors, Q-colors and any user colors under the test and 
reference light sources and writes then to an Excel file names CRI_CQS_u’u’.xls. 

x. “Write the binning runs to a file” 

The individual x,y points from a binning run will be written to a text file. 

xi. “Gamut based on 1976 (u'v') diagram” 

The gamut areas based on the 1976 diagram will be displayed in the UI.  

xii. “Gamut based on 1960 (uv) diagram” 

The gamut areas based on the 1960 diagram will be displayed in the UI. Note that the gamuts 
themselves are ratios and have the same values on the 1976 and 1960 diagrams. Only the gamut 
areas are different. 

xiii. “Limit umol/s and umol/J to 400 nm to 700 nm” 

The calculation of these quantifies will be limited to the wavelength range of 400 nm to 700 nm 
instead of the usual 360 nm to 830 nm. 

 
e. Matching Menu 

 
i. “Matching mode” 

Adds a third column to the spectrum table. An additional spectrum can be pasted into this 3rd 
column to be plotted along with the original spectrum. The name of the matching spectrum can 
be changed in the spectrum plot window. 

ii. “Plot normalized data” 

Normalize the original and matching spectra before plotting. 
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iii. “User entered” 

The user pastes the desired spectrum into the table. 

iv. “Use the black body curve as the matching spectrum” 

The user can enter a value for the black body spectrum and it will be calculated and used as the 
matching spectrum. 

v. “Use the reconstituted daylight curve as the matching spectrum” 

The user can enter a value for the reconstituted daylight spectrum and it will be calculated and 
used as the matching spectrum 

vi. “Use the 1931 2° photopic ( y  ) curve as the matching spectrum” 

Use the 1931 2° photopic ( y  ) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

vii. “Use the 1931 2° photopic ( x  ) curve as the matching spectrum” 

Use the 1931 2° photopic ( x  ) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

viii. “Use the 1931 2° photopic ( z  ) curve as the matching spectrum” 

Use the 1931 2° photopic ( z  ) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

ix. “Use the 1931 2° scotopic ( y  ) curve as the matching spectrum” 

Use the 1931 2° scotopic ( y  ) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

x. “Use the 1960 10° photopic ( y  ) curve as the matching spectrum” 

Use the 1960 10° photopic ( y  ) curve as the matching spectrum, the spectra will be normalized 

before plotting. 
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xi. “Use the 1960 10° photopic ( x  ) curve as the matching spectrum” 

Use the 1960 10° photopic ( x  ) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

xii. “Use the 1960 10° photopic ( z  ) curve as the matching spectrum” 

Use the 1960 10° photopic ( z  ) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

xiii. “Use the 2015 2° photopic ( y  ) curve as the matching spectrum” 

Use the 1931 2° photopic ( y  ) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

xiv. “Use the 2015 2° photopic ( x  ) curve as the matching spectrum” 

Use the 2015 2° photopic ( x  ) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

xv. “Use the 2015 2° photopic ( z  ) curve as the matching spectrum” 

Use the 2015 2° photopic ( z  ) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

xvi. “Use the 2015 10° photopic ( y  ) curve as the matching spectrum” 

Use the 2015 10° photopic ( y  ) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

xvii. “Use the 2015 10° photopic ( x  ) curve as the matching spectrum” 

Use the 2015 10° photopic ( x  ) curve as the matching spectrum, the spectra will be normalized 

before plotting. 
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xviii. “Use the 2015 10° photopic ( z  ) curve as the matching spectrum” 

Use the 2015 10° photopic ( z  ) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

 

f. User Spectra Menu 
 

i. “Save as a user spectrum…” 

After a spectrum has been calculated it can be saved for future use. The spectrum can be from a 
combination of existing spectra, pasted into the table or read from a file. You can enter any 
name you like and enter an LPW if it is known. Any saved user spectra are saved to a file called 
“userSpectra.spec” in the directory where the ColorCalculator.exe is. It is a plain ascii file and 
can be read in most text editors. You can move the file around, make copies or rename it. Each 
time the program starts it looks for a file called “userSpectra.spec” and reads in any spectra 
found within. 

ii. “Import user spectra (add to current ones)…” 

Open and read in saved spectra. You will be prompted for a file to open. This file must be in the 
correct format so it is almost always a previously renamed “userSpectra.spec” file. The spectra 
read-in will be added to any existing user spectra. 

iii. “Read a saved user spectra file (replace current ones)…” 

Open and read in saved spectra. You will be prompted for a file to open. This file must be in the 
correct format so it is almost always a previously renamed “UserSpectra.spec” file. The spectra 
read-in will replaced any existing user spectra. A file called “userSpectra_bck.spec” will contain 
the contents of the old “userSpectra.spec” file if any existed. 

iv. “Edit user spectra…” 

Opens a new window allowing the user to rename, reorder, change the LPW, or delete any user 
spectra in the current file. 

v. “Create user spectra from pure color or Gaussian peaks...” 

You can enter the peak parameters to define a pure color LED peak or a Gaussian peak which 
will be added to your user spectra. 

 



50 | P a g e  
 

 

vi. “Standard illuminates” 

You can select standard illuminates to be added to your user spectra. 

vii. “Import *.isd SpecWin data file…” 

You can select files created by the SpecWin software and directly import them as user spectra. 

viii. “Import *.txt SpectraSuite data file…” 

You can select files created by the SpectraSuite software and directly import them as user 
spectra. You will be prompted to enter the intensity units (W/nm, mW/nm or µW/nm) for the 
spectrum. 

ix. “Import *spdx (IES XML) spectrum data file…”  

You can select files in the IES XML and directly import them as user spectra. 

x. “Import data file (1st column is nm, 2nd column is intensity) …” 

These files can be from any source and any wavelength range or interval. The data can be 
separated by spaces or tabs, commas may also work depending on the symbol used as the 
decimal point. You will be prompted to enter the intensity units (W/nm, mW/nm or µW/nm) for 
the spectrum. In this file format you can have up to 100 spectra in the same file in different 
columns as long as they all have the same wavelengths, only the first column is used for the 
wavelength, the other columns will be considered as holding the intensity. 

xi. “Import data file (1st column is intensity, 2nd column is nm) …” 

These files can be from any source and any wavelength range or interval. The data can be 
separated by spaces or tabs, commas may also work depending on the symbol used as the 
decimal point. You will be prompted to enter the intensity units (W/nm, mW/nm or µW/nm) for 
the spectrum. In this file format you can have only 1 spectrum in the file. 

xii. “Include the filename in the spectrum name” 

The filename will be prepended to the spectrum name when it is read into the software. You can 
rename the spectra later using the “Edit user spectra…” command. 
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g. User Filters Menu 
 

i. “Save as a user filter…” 

After a filter has been entered and calculated it can be saved for future use. The filter must 
paste into the table when in “Filter input” mode. You can enter any name you like. Any saved 
user filters are saved to a file called “userFilters.fils” in the directory where the 
ColorCalculator.exe is. It is a plain ascii file and can be read in most text editors. You can move 
the file around, make copies or rename it. Each time the program starts it looks for a file called 
“userFilters.fils” and reads in any filters found within. 

ii. “Import user filters (add to current ones)…” 

Open and read in saved filters. You will be prompted for a file to open. This file must be in the 
correct format so it is almost always a previously renamed “userFilters.fils” file. The filters read-
in will be added to any existing user spectra. 

iii. “Read a saved user filters file (replace current ones)…” 

Open and read in saved filters. You will be prompted for a file to open. This file must be in the 
correct format so it is almost always a previously renamed “userFilters.fils” file. The spectra 
read-in will replaced any existing user filters. A file called “userFilters_bck.fils” will contain the 
contents of the old “userFilters.fils” file if any existed. 

iv.  “Edit user filters…” 

Opens a new window allowing the user to rename, reorder, or delete any user filters in the 
current file. 

v. “Import data file (1st column is nm, 2nd column is transmission) …” 

These files can be from any source and any wavelength range or interval. The data can be 
separated by spaces or tabs, commas may also work depending on the symbol used as the 
decimal point. In this file format you can have up to 100 transmission curves in the same file in 
different columns as long as they all have the same wavelengths, only the first column is used 
for the wavelength, the other columns will be considered as holding the transmission. 

vi. “Import data file (1st column is transmission, 2nd column is nm) …” 

These files can be from any source and any wavelength range or interval. The data can be 
separated by spaces or tabs, commas may also work depending on the symbol used as the 
decimal point. In this file format you can have only 1 transmission curve in the file. 
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vii. “Include the filename in the filter name” 

The filename will be prepended to the filter name when it is read into the software. You can 
rename the filters later using the “Edit user filters…” command. 

viii. “Uncheck all user filters” 

Uncheck any checked user filters. 

ix. “Allow values greater than 1 or 100%” 

If this option is checked than values greater than 1 or 100% will be allowed. If this is not checked 
a warning will be shown. 

 

h. User Colors Menu 
 

i. “Save as a user color…” 

After a color has been entered and calculated it can be saved for future use. The color must 
paste into the table when in “Color input” mode. You can enter any name you like. Any saved 
user colors are saved to a file called “userColors.cols” in the directory where the 
ColorCalculator.exe is. It is a plain ascii file and can be read in most text editors. You can move 
the file around, make copies or rename it. Each time the program starts it looks for a file called 
“userColors.cols” and reads in any colors found within. 

ii. “Import user colors (add to current ones)…” 

Open and read in saved colors. You will be prompted for a file to open. This file must be in the 
correct format so it is almost always a previously renamed “userColors.cols” file. The colors 
read-in will be added to any existing user colors. 

iii. “Read a saved user colors file (replace current ones)…” 

Open and read in saved colors. You will be prompted for a file to open. This file must be in the 
correct format so it is almost always a previously renamed “userColors.cols” file. The spectra 
read-in will replaced any existing user colors. A file called “userColors_bck.cols” will contain the 
contents of the old “userColors.cols” file if any existed. 

iv. “Edit user colors …” 

Opens a new window allowing the user to rename, reorder, or delete any user colors in the 
current file. 
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v. “Import data file (1st column is nm, 2nd column is reflectance) …” 

These files can be from any source and any wavelength range or interval. The data can be 
separated by spaces or tabs, commas may also work depending on the symbol used as the 
decimal point. In this file format you can have up to 100 reflectance curves in the same file in 
different columns as long as they all have the same wavelengths, only the first column is used 
for the wavelength, the other columns will be considered as holding the reflectance. 

vi. “Import data file (1st column is reflectance, 2nd column is nm) …” 

These files can be from any source and any wavelength range or interval. The data can be 
separated by spaces or tabs, commas may also work depending on the symbol used as the 
decimal point. In this file format you can have only 1 reflectance curve in the file. 

vii. “Include the filename in the color name” 

The filename will be prepended to the color name when it is read into the software. You can 
rename the colors later using the “Edit user colors…” command. 

viii. “Check all user colors” 

Check all of the user colors. 

ix. “Uncheck all user colors” 

Uncheck any checked user colors. 

 

i. CIE Plot Menu 

More options are available in the main CIE diagram window. Additional customizations involving 
MacAdams ellipses and point symbols, colors and labels are also available from the Duv toolbar 
button. 

i. “Color filled CIE space” 

Fill the CIE diagram with color. 

ii. “Unfilled CIE space” 

Do not fill the CIE diagram with color, it will be white. 

iii. “Show grid lines” 

Show grid lines in the CIE plot. 
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iv. “Locus lines” 

You can pick which locus to show, black body, daylight, TM-30-18 or none. 

v. “Show CCT lines” 

Youi can pick from a selection of CCT lines to display. 

vi. “ANSI quadrangles” 

Select to display the various ANSI quadrangles. 

vii. “Photometry text” 

An abbreviated summary of the photometry will be displayed on the CIE diagram. The location 
of this label can be selected. 

viii. “Out-of-gamut color” 

You can chance the display of the out-of-gamut region of the CIE diagram. This is only active 
when you have a gamut selected. 

ix. “Draw gamut boundary line” 

Determines whether a line is drawn as the gamut is boundary. 

x. “Gamuts” 

Select standard gamuts to be drawn on the CIE diagram. 

xi. “Solid gamut lines” 

Draws the gamut lines as solid line if checked, if not checked each line is drawn with a different 
dashed line. 

xii. “MacAdam ellipse” 

Select which of the MacAdam ellipses to display. These ellipses are based on equations from: 
Chickering, JOSA V57 n4, 1967, "Optimization of the MacAdam-Modified 1965 Friele Color-
Difference Formula" and Chickering, JOSA V61 n1, 1971, "FMC Color-Difference Formulas: 
Clarification Concerning Usage" 

xiii. “u’v’ circles” 

Draw the u’v’ circles, as defined in CIE TN 001:2014, on the CIE diagram. 
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xiv. “Ellipse/Circle color” 

You can select the color used for the MacAdam ellipse or u’v’ circle. 

xv. “Use thick line” 

You can select whether to use a thick line when drawing the  MacAdam ellipse or u’v’ circle. 

xvi. “Symbol size” 

Select the size of the x,y point symbol 

xvii. “Show raw spectra with points and lines” 

A point representing each individual checked spectra along with a dotted line connecting it to 
the sum of the check spectra will be displayed. 

xviii.  “Show wavelength markers” 

Show the wavelength markers on the outer CIE horseshoe. 

xix.  “Enable SmartZoon (center at x,y)” 

Center the CIE diagram at the x,y of the spectrum. 

 
j. Spectrum Plot Menu 

More options are available in the main spectrum plot window.  

i. “Plot with white background” 

Do not fill the plot with color. 

ii. “Plot with rainbow under curve” 

Fill the plot with color only under the curve. 

iii. “Plot with rainbow background” 

Fill the entire plot with color. 

iv. “y-Axis is umol/s when input units are photons/s” 

Changes the y-axis units of the plot to umol/s when the input units of the spectrum are 
photons/s. 
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v. “Draw color patch (at 6500K) on plot when plotting colors/filters” 

Display a patch representing the color/filter under 6500K daylight on the plot. 

vi. “Write the photometry or the filter/color name on the plot” 

Display a summary of the photometry or the filter/color name on the plot. 

vii. “Position plot legends top left” 

Draw the caption and color patch in the top left corner. 

viii. “Position text and color patch top right” 

Draw the caption and color patch in the top right corner. 

ix. “Position text and color patch bottom right” 

Draw the caption and color patch in the bottom right corner. 

x. “Position plot legends bottom left” 

Draw the caption and color patch in the bottom left corner. 

xi. “Fill the legend background” 

Fill the legend background to mask the plot behind it if they overlap. 

xii. “Keep y-axis for filters and colors at full scale (1 or 100)” 

For filters and color plots do not scale the y-axis, keep it at 1 or 100%. 

xiii. “Show grid lines” 

Draw vertical grid lines. 

xiv. “Show box around plot” 

Draw the top and right side axis lines. 

xv. “Show color peak lines on plot” 

Draw short vertical lines to indicate the color. This is only useful when you draw an unfilled plot, 
i.e., no rainbow. 
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xvi.  “Enable mouse wheel zoom” 

When this is checked scrolling the mouse wheel when over the spectrum plot will zoom the 
wavelength axis in or out. The zoom will take place centered at the wavelength where the 
mouse is positioned. 

 
k. IES TM-30-18 Menu 

 
i.  “IES TM-30-18 chroma, hue shifts and Rf histograms for the 16 hues“ 

Uses the last calculated spectrum to make the plot. Use the “Image Type” menu item in the plot 
window to switch between the different plot types. 

ii. “IES TM-30-18 color Rf histogram for the reference colors“ 

Uses the last calculated spectrum to make the plot. 

iii. “IES TM-30-18 color patches“ 

Uses the last calculated spectrum to make the plot. The appearance of the reference colors 
under the test and reference spectra are displayed. 

iv. “IES TM-30-18 Rg versus Rf plot“ 

Uses the last calculated spectrum to make the plot. 

v. “IES TM-30-18 color vector graphic and icon plots“ 

Uses the last calculated spectrum to make the plot. Use the “Image Type” menu item in the plot 
window to switch between the two plot types. 

vi. “IES TM-30-18 gamut area plot“ 

Uses the last calculated spectrum to make the plot.  

vii.  “IES TM-30-18 CAM02-UCS plot“ 

Uses the last calculated spectrum to make the plot. 

viii. “IES TM-30-18 report” 

Creates the IES TM-30-18 report as a bitmap. The user is prompted to enter values for the 
various text fields. 
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ix. “Use the selected user colors in place of the standard TM-30-18 reference colors” 

The 99 standard reference colors defined in TM-30-18 will be replaced with ones you’ve 
checked. 

x. “Write IES TM-30-18 J‘a’b‘, Rf,i and Rf,h values to a file…“ 

Write the values for the last calculated spectrum. 

 

l. Other Plots Menu 
 

i. “3D CIE L*a*b* & CAM02-UCS J*a*b* plots with current spectrum” 

Opens a new window where you can enter your own display 3D CIE L*a*b* & CAM02-UCS 
J*a*b* plots and animate these. 

i. “3D CIE L*a*b* plot with user inputted values...” 

Opens a new windows where you can enter your own L*a*b* values to make a 3D CIELab plot. 

ii. “CIEL*a*b* plot with user inputted values...” 

Opens a new windows where you can enter your own L*a*b* values to make a CIELab plot. 

 

m. Other Calculations Menu 
 

iii.  “Calculate CIEDE2000 with user inputted values...” 

Opens a new window where you can L*a*b* values and calculate various CIEDE2000 quantities. 

iv. “Calculate CCT, Duv, dominant wavelength and purity from x,y…” 

Opens a new window where you can enter x, y values and the corresponding u’v’, CCT and Duv 
values will be calculated. You can also make highly customized CIE plots from this window. You 
can enter x,y points to plot, select different MacAdams ellipses, specify your own, change the 
point size, symbol, color and add captions to the points. This window can also be open with the 
Duv toolbar button. This is the main function to make customized CIE plots. 

v. “Calculate x,y from CCT & Duv…” 

Opens a new window where you can enter CCT and Duv values and the corresponding x,y values 
are calculated. 
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vi. “Convert coordinates (xy/uv/u'v'/XYZ/L*a*b*)...” 

Opens a new window where you can enter one set of coordinates and the other sets of 
coordinates are calculated. 

vii.   “Convert between RGB, HSV and HSL systems” 

Opens a new window where you can enter one set of values and the other sets of values are 
calculated. 

viii.   “Convert Cx, Cy to RGB, HSV and HSL systems” 

Opens a new window where you can enter Cx and Cy values and the other sets of values are 
calculated. 

ix. “Calculate gamut area coverage…” 

Opens a new window where you can enter your gamut and have its coverage compared to other 
standard gamuts. 

x.  “Calculate the black body locus and CCT lines…” 

Opens a new window where you can enter minimum and maximum CCT values and the x,y 
coordinated of the black body line will be written to a tab delimited file called 
“blackBodyLocus.txt”. 

xi. “Calculate the coordinates of MacAdams ellipse or u’v’ circle…” 

Opens a new window where you can enter an x,y point along with the size of the MacAdams 
ellipse or the u’v’ circle and points representing the ellipse or circle will be calculated. 

xii. “Calculate circadian system response…” 

Opens a new window where you calculate the circadian/melatonin suppression metric based on 
work by M.S. Rea, M.G. Figueiro, J.D. Bullough, A. Bierman and R. Hamner at the Lighting 
Research Center, Rensselaer Polytechnic Institute, Troy, New York, USA.  

xiii. “Calculate binning from x,y and lumens…” 

Opens a new window where you can enter x, y and lumens along with wavelengths and Cx, Cy 
bin widths and Monty Carlo simulations are used to estimate the expected variation in color. 

xiv. “Calculate photometry from x,y and lumens…” 

Opens a new window where you can enter x, y and lumens of several light sources and the 
resultant photometry of all of the light sources combined is calculated. 
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xv. “Calculate 3 color mixing based on x,y…” 

Opens a new window where you can enter the x,y values of your three colors. In another table 
you enter the target CCT and Duv or x and y, and the total lumens you want. The program will 
then calculate the lumens required of each of the three colors to hit your target. 

xvi. “Calculate maximum lumens from color mix…” 

Opens a new window where you can enter the x,y values of your colors. If you check LEDs in the 
main window and press the “Cal. Individual” button before open this window you wll be able to 
press the “Use last” button to copy the LED data into the table, you can also enter values into 
this table manually.  You enter the color mixes in terms of visible watts and the maximum 
lumens you can are reported.  

xvii. “Calculate color mixing based on spectra…” 

Opens a new window where you can mix up to 4 spectra. These must be checked in the main 
window before you click this command. You can enter different intensities of these peaks and 
the photometry will be calculated. 

xviii. “Multi-design optimization…” 

Opens a new window where you can enter several optimization target designs to run at once. 

xix. “Resample spectrum…” 

Opens a new window where you can paste in a spectrum and resample it at any wavelength 
interval. 

xx. “Bin substitution…” 

Opens a new window where you select an existing spectrum, then select several other spectrum 
to combine to hit the same x,y color point. 

xxi. “Mix by sliders…” 

Opens a new window where you can adjust the amount of each spectra and the wavelength of 
the pure color LEDs using sliders for an interactive experience. 

 

n. Other Options Menu 
 

i. “Resize window to fit screen size” 
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When changing screen resolution the main window may be slightly off the screen, this 
command will resize and reposition it so it fits. 

ii.  “Reset the working directory to the default directory” 

Sometimes you’ve navigated to a different directory to read some data files. This command will 
reset the directory to the program default. 

iii. “Program font…” 

Change the font used for the UI. 

iv. “Write the R1-R15 colors to a file (R_values.cols)” 

Writes the reflectance spectra of the 15 CIE reference colors to a file. These can then be read-in 
as user colors or used in other software. 

v. “Write the Q1-Q15 colors to a file (Q_values.cols)” 

Writes the reflectance spectra of the 15 CQS reference colors to a file. These can then be read-in 
as user colors or used in other software. 

vi. “Write the ColorChecker (TLCI) colors to a file (ColorChecker_colors.cols)” 

Writes the reflectance spectra of the ColorChecker (TLCI) reference colors to a file. These can 
then be read-in as user colors or used in other software. 

vii. “Write the CES colors to a file (CES_values.cols)” 

Writes the reflectance spectra of the 99 CES reference colors to a file. These can then be read-in 
as user colors or used in other software. 

viii.  “Write photometry coefficients file” 

Writes several of the photometric constant to a file. The following files are written: 
"XYZ_coeff.xls", "TCS_VS_coeff.xls", "CCT_coeff.xls", "daylight_coeff.xls". 

ix. “Write the CIE horseshoe data to an Excel file” 

The coordinates of the 1931 2° and 2015 10° horseshoes are written to a file (CIE_horseshoe.xls) 
for use in other software. 

x.  “Play sounds” 

Beeps when a run is completed. 

xi. “Enable sticky menus” 



62 | P a g e  
 

 

Keeps certain menus open after a selection is made. 

xii. “Enable mouse wheel in LEDs input fields (ldom, bin width and output)” 

You can use the mouse wheel to easily change the values of these fields. 

xiii.  “Show all standard LEDs” 

Shows all of the standard spectra what come with the software. User spectra are shown. 

xiv.  “Do not show generic pure color standard LEDs” 

Do not show any of the pure color spectra what come with the software. User spectra are 
shown. 

xv. “Do not show IR standard LEDs” 

Do not show the standard spectra for the IR LEDs what come with the software. User spectra are 
shown. 

xvi. “Do not show any standard LEDs” 

Do not show any of the spectra what come with the software. User spectra are shown. 

xvii. “Show CIE and CQS test colors and TM-30 hue colors” 

Set the background color of the individual R, Q and TM-30 Rf values cell to an approximate 
representation of the actual R, Q or TM-30 hue value at D65. 

xviii. “Show tab highlight colors” 

Highlights the “Spectra”, “Filters”, “Colors”, “Optimization” tabs with colors to make them more 
visible. 

 

o. Color Systems Menu 
 

i.  “Natural Colour System (NCS)…” 

Opens a new window where you can access the colors in the NCS system. These colors can be 
individually selected and saved as user colors. 
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Help Menu 

 
i. “ColorCalculator web site” 

Opens a web browser to the home page of this program. You can check if a new version is 
available. 

ii. “Check the web site for updates” 

Checks to see if a new version of the software is available. 

iii. “Check for updates at start-up every 7 days” 

Checks to see if a new version of the software is available when you start the program every 7 
days. 

iv. “Check for updates at start-up every 30 days” 

Checks to see if a new version of the software is available when you start the program every 30 
days. 

v.  “Open pdf User Guide” 

Opens a pdf version of this file if it exists in your local directory. 

vi. “View license agreement” 

Display the license agreement. 

vii. “OSRAM Opto Semiconductors web site of LED spectra” 

Opens a brower to a web site with the spectra of current OSRAM Opto Semiconductors LEDs. 

viii. “About” 

Gives some very general information about this program. 


